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Методи на запълване
Adobe Illustrator предлага 2 метода на 
запълване:

Метод 1. Прилагане на запълване, контур или 
и двете върху обект.

Метод 2. Конвертиране на обект в „Live Paint“ 
група и прилагане на запълване и/или контур 
върху различните части в нея.



Метод 1. Оцветяване на обект
-Рисува се обект.
-Селектира се и му се прилага запълване (Fill Color), контур (Stroke) 
или и двете.

-След това може да се нарисува друг обект и да се оцвети
чрез същия подход.
-Всеки един от обектите е в свой собствен слой.
-Слоевете са подредени в ред, спрямо който зависи и 
подредбата на обектите на платното.

-Резултатът е колаж от фигури, оцветени по различен
начин, които в своята цялост представляват финалното 
изображение.





Метод 2. Оцветяване на Live Paint група
– Live Paint е интуитивен подход за колоризация на черно-бели 

векторни изображения.

– Конвертирайки вашата илюстрация в Live Paint група, може да 
я оцветим по същия начин, както ако тя беше на хартия.

– Всеки затворен път може да се запълни и обточи по различен 
начин.

– Няма отделни слоеве и обекти едни върху други, всичко се 
третира като една повърхност.





Недостатъци
Върху отделните сегменти не могат да се прилагат 
редица функции на илюстратор (Transparency, Effects 
Gradient meshes, Graphs, Symbols from the Symbols 
panel, Flares, Align Stroke, Magic Wand tool, командите 
от Pathfinder и много други).



Създаване на Live Paint група
1. Избирате един или повече затворени пътища.
2. Object > Live Paint > Make.
3. Избираме Live Paint Bucket tool     кликваме 
по отделните сегменти, за да ги оцветим.



1. Използвайте Live Paint Selection Tool    , за 
да селектирате отделни елементи в групата.

2. Използвайте Selection Tool   , за да 
селектирате цялата Live Paint Група.

3. Използвайте Direct Selection Tool , за да 
селектирате пътища вътре в Live Paint 
групата.

Селектиране на елементи 
от Live Paint група



Дупките са малки пространства между пътищата.

Ако боята изтече към фигура, която не сте искали да 
оцветите, то значи пътят не е затворен и има дупка.

Може да създадете нов път, който да затвори 
дупката, да редактирате вече съществуващия път или 
промените опциите за дупки в Live Paint групата.

Откриване и затваряне на дупки
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Откриване и затваряне на дупки (gaps), през които
„изтича боята“ в Live Paint група

Object > Live Paint > Make
Ако има несвързан път, боята ще прелее и в другата форма



Откриване на дупки
View > Show Live Paint Gaps.

С тази команда всички 
дупки се посочват с 
червен контур.



Промяна на Gap опциите
Object > Live Paint > Gap 
Options

Gap Detection – ако е избрана тази 
опция, Illustrator сам намира 
дупките и не позволява изтичане 
на боя през тях.

Paint Stops At – Задава се 
максимален допустим размер на 
дупка, така че да не прелива боя 
през нея.



Промяна на Gap опциите
Gap Preview Color –
Избор на цвят за индикация на 
местата с дупка.

Close Gaps With Paths – При 
избор, добавя автоматично 
пътища, които запълват отделните 
дупки.



Контур
Контур (stroke) са външните очертания на фигурата.



Оттук може да се променят:
-Дебелината на контура
-Тип на заобляне на ъглите
-Дали да e външен, вътрешен, 
центриран

-Типа на линията (прекъсната, 
гладка и други)

Контур
Опциите за контур в AI се намират 
чрез Window > Stroke



Добавяне на контур
Контур може да бъде добавен върху цял обект или върху 
сегмент от Live Paint група.

1. Избираме обекта.
2. Кликваме върху квадратчето Stroke вляво най- долу на 

лентата с инструменти в Illustrator. По този начин 
индикираме, че ще добавяме контур, а не запълване.

3. Избираме цвят от Color панела, шарка от Swatches
панела или с двоен клик върху квадрата Stroke 
отваряме цветовата палитра.

4. Изберете дебелина на контура.



Добавяне на прекъснат контур
– Избираме обекта.
– В панела Stroke избираме за тип на линията 

“Dashed” .
– Кликнете върху иконата Align Dashes to 

Corners and Path Ends, като по този начин 
линията променя позициите си, така че да бъде 

видима по ъглите на фигурата и краищата на 
пътя.



Тип на прекъснат контур
В панел Stroke може да 

избираме различни опции 
(A, B, C) за тип на заобляне в 
краищата на прекъснатия 
контур.
Това става от опцията “Cap”.





Градиенти



Градиентите се 
използват за 
създаването на 
преливки.

Градиенти



1. Селектираме обект
2. Кликване на квадратчето Gradient

в панела с инструменти или Gradient 
Fill в Gradient панела

3. Отваряме панела Gradient и 
променяме цветовете, техните 
позиции и типа градиент

4. Цветовете се променят като кликнем 
два пъти върху съответния маркер и 
изберем цвят от палитрата

Запълване на обект с градиент



A. Gradient Fill box
B. Gradient menu
C. Fill Gradient
D. Stroke Gradient
E. Reverse Gradient
F. Midpoints
G. Color Stop
H. Opacity
I. Location
J. Panel Menu

K. Stroke Gradient Type
L. Angle

M. Aspect Ratio
N. Delete Stop

Панелът Gradient (Window > Gradient)



Типове градиенти
1. Линеен
2. Радиален
3. Елипсовиден



Линеен градиент
С линейния градиент можем да създаваме преливки, 
като при тях цветовете и светлината се разпространяват 
праволинейно. Можем да променяме ъгъла (посоката на 
разпространение).



Радиален градиент
При радиалния градиент цветовете и светлината се 
разпространяват като концентрични окръжности.



Елипсовиден градиент
При елипсовидния градиент 
Преливката се получава под 
формата на елипса, която също 
може да променя своя ъгъл.







Цветовете през 2025



Цветовете през 2025



Цветовете през 2025

https://benjaminmoore.pl/en/colors-and-inspirations/color-of-the-year-2025/



Цветовете от различни аспекти
Цветът е един от базовите елементи в един дизайн. Внимателно 
обмисленият и балансиран подбор на цветове може да стане основа 
за успешна композиция, дори и останалите елементи да са по- 
тривиални. Във вселената на цветовете съществуват 
основополагащи закони, които всеки дизайнер е длъжен да знае и да 
ги прилага в практиката.
В предната част на човешка ретина се намират "пръчици", 
отговарящи за възприемането на тона и "колбички", които имат 
отношение към възприемането на цвета.
При различните хора съотношението между пръчици и колбички е 
различно и затова възприятието е такова. То е субективно за 
всеки човек. Така различните хора имат различни любими цветове 
и усещания, предизвиквани от един или друг цвят.



Цветовете от различни аспекти
В мозъка ни цветовете се възприемат в зависимост от това, каква 
форма или площ заемат обектите, оцветени с тях и какви са 
заобикалящите оттенъци.
При намаляване на заеманата от цвета площ се намалява 
количеството оттенъци, които може да различи окото и повечето 
цветове започват да изглеждат по-бледи и по-тъмни, особено ако 
яркостта и наситеността им и без това са били на ниски.
За по-малките елементи трябва да се избират по-ярки цветове, а 
за да се покаже цялата красота на някой тъмен, слабо-наситен 
оттенък е необходимо достатъчно пространство (например, фонът 
на цялата страница).



• Цветовете, достатъчно близки до черното или бялото, трудно 
могат да бъдат изразени ефективно дори и разположени върху 
площ с огромни размери.

• Всеки два цвята поставени близко един до друг се възприемат 
по-различно, отколкото ако стоят самостоятелно.

• Ако съседните цветове имат приблизително еднаква яркост, то 
те са склонни да обменят наситеността и цвета си.

• По-тъмният цвят в съседство с по-светъл придобива още
по-тъмен "ръб", а светлият точно на самата граница изглежда 
по-ярък.

Цветовете от различни аспекти



Основни указания при използване на цветовете
Текстът трябва да се чете. Очевидно черно на бяло е най- 

разпространеният и подразбиращ се избор, но има и други, които 
също са добри. Бял или жълт цвят, или пък други светли цветове на 
черен фон също изглеждат добре, докато жълт, зелен или сив на 
бял фон – не.
Използвайте цветове, които са атрактивни и приятни за окото.
Изберете цветове, които обрисуват картината, която бихте искали 

да представите на вашите посетители.
Не използвайте изображения или графики, които са наситени, като 
фон на сайта ви. Това прави текста трудно четим. Ако искате все пак 
да има изображение може да ползвате бледо, като воден знак, 
което само загатва за себе си.
Цветовете трябва да са еднакви за всичките ви страници, за да 

се създаде марка и уникална визия на вашия уеб сайт.

Цветовете от различни аспекти



Изборът на правилните цветове за вашия уеб сайт е от първостепенно 
значение, както и подбора на графичното и текстово съдържание. За никого 
не е тайна, че цветовете влияят върху човешкия мозък и психиката.
Някои цветове могат да предизвикат специфични емоции у хората.

Неутрални цветове

Бяло – Бялото е символ на чистотата и непорочността. В източните култури 
това е цвета на смъртта, докато в западните – на брака и надеждата.
Сиво – Сивите нюанси излъчват надеждност и консерватизъм. Оттенъците на 
сивото са едни от най-популярните цветове за бизнес облеклото.
Кафяво – Символ на земята, дома и семейството.
Черно – Черното изразява сила, елегантност и съвършенство. Освен това в 
западните култури то е цветът на смъртта.

Цветовете от различни аспекти



Топли цветове
Червено – Червените нюанси са идеални за привличане на внимание. 
Ето защо са често използвани в писма за продажби, за да подчертаят 
специална точка. Червеното символизира гневът, насилието, похот, 
страст и всъщност може да повиши и кръвното налягане на хората.
Жълто – Жълтото може да означава, както слабост и страхливост, така и 
топлота и щастие.
Оранжево – Оранжевите цветове може да се асоциират с есенната 
реколта или Хелоуин. Освен това то стимулира апетита.
Розово – Розовото обикновено символизира невинност, женственост и 
романтика.

Цветовете от различни аспекти



Студени цветове
Син – Влияе успокояващо. Символ на интелигентността и 
истината, професионализма. Изненадващо много финансови и 
здравни институции използват, именно, тази палитра. Синият 
цвят също така потиска апетита.
Зелен – Освен че зеленият цвят е символ на ревност, алчност и 
неопитност, той също така представя парите и заможността. 
Виолетов, Лилав – Лилавото символизира творческите 
способности. По-тъмните нюанси се асоциират с величественост, 
докато по-светлите са свързани с романтиката.

Цветовете от различни аспекти





Човешкото око не може да се фокусира едновременно върху 
червения и синия цвят.

Като предложение: топлите цветове като червено, кафяво, 
оранжево и жълто изглеждат добре в комбинация. Същото 
важи за студените синьо, зелено, сиво и бяло.

Никога не използвайте син цвят на текст върху червен фон 
или още по-лошо: червено върху синьо

Цветовете от различни аспекти



Спазвайте плавен, ниска стойност на контраста. Повечето страници са
бели с черен цвят на шрифта. За начало изглежда супер, но ако статиите са
дълги в даден момент натоварват окото и стават трудни за четене. Светло
сивото за свят на текста върху тъмно сив фон е много по-добро решение за
лесното фокусиране на потребителя, но не е най-добрата комбинация.
Която и да изберете, дръжте контраста под око. Ако фона ви има стойност 20%, 
нека текста да е с цвят 80%, избягвайте крайностите.

Цветовете от различни аспекти



Цветови и файлови формати за Уеб и печат
Цветови модели RGB и CMYK

Използват различни методи за възпроизвеждане на цветовете, с различна 
цветова гама или диапазон на цветовете.

Не всички RGB и CMYK гами са еднакви. Всеки модел монитор и принтер е 
различен, затова възпроизвеждат малко по-различна гама спрямо останалите 
устройства в своя клас.

С RGB модела бялата светлина се получава чрез сумиране на RGB цветовете, 
затова те се наричат адитивни, а самата система адитивно смесване на 
цветовете.

CMYK се основава на свойството на печатарските мастила, отпечатани върху 
хартия, да поглъщат и отразяват различни части от видимия спектър (C+M+Y= 
чисто черен цвят на теория при припокриване, но реално се получава мръсно 
кафяв. Затова се използва четвърти К (blacK). Те се наричат субтрактивни цветове, 
защото се получават като се изваждат части от бялата светлина.



Цветови и файлови формати за Уеб и печат



Cyan Cyan + Magenta Cyan+ Magenta+Yellow Cyan+ Magenta+Yellow+Black



CMYK – Cyan, Magenta, Yellow, blacK

Цветови и файлови формати за Уеб и печат



RGB – Red, Green, Blue

Цветови и файлови формати за Уеб и печат



RGB – цветови модел
RGB е най-разпространения цветен модел за компютърни изображения. 
Възможни са 256 стойности за всеки от трите основни цвята: червено, 
зелено, синьо. Без сериозни математически познания можем да 
изчислим, че съществуват 16 777 216 комбинации между тях, при 
получаване на нови цветове. Това са над 16 милиона различни цвята...

Компютрите започват да броят от "0" за разлика от нас. Затова 
възможните RGB стойности са от "0" до "255". Когато всички стойности са 
"0" (за Red, Green и Blue), резултатният цвят ще е "черно". Когато всички 
стойности са "255" (за Red, Green и Blue), резултатният цвят ще е "бяло".
Ако R=0, G=0 и B=255 очакваният цвят е "ослепително синьо" и т.н. 
аналогично за червено и зелено. При миксиране на различни стойности за 
Red, Green и Blue можем да получим над 16,7 милиона различни цвята.

Цветови и файлови формати за Уеб и печат



HSL/HSB/HSV – Hue, Saturation, Luminance/Briteness/Value

Цветови и файлови формати за Уеб и печат



Всеки един цвят се разлага на трите си съставни от системата HSV
(Hue-тон, Saturation-наситеност, Value-яркост).
"Hue" – тон. Приемаме го като цвят или цветен нюанс, все едно да се 
разхождаш по дъгата, стъпвайки от цвят на цвят.

"Saturation" е наситеността (количеството) на всеки един цвят. Определя колко 
да е зелено зеленото, например. Когато намалява клони към сиво.

"Luminance", "Brightness" или “Value" е осветеността (яркостта, силата) на 
цвета. При добавяне на luminance, получавате по-светла версия на цвета, с 
който работим и обратно.

Обикновено ако настройваме цвят със софтуерна програма, и двата 
модела HSL и RGB използват един и същ диалогов прозорец, както е в 
Adobe Illustrator например. Когато търсите или настройвате определен 
цвят HSL модела е по-удобен от RGB модела.

Цветови и файлови формати за Уеб и печат



Цветовете от различни аспекти
Tint (нюанс) – Цветът, получен 
при добавяне на бяло към друг 
цвят.
Tone (тон) – Цветът, 

получен при добавяне на 

сиво към друг цвят

Shade (сянка) – Цветът, 

получен при добавяне на 

черно към друг цвят.



Indexed Color модел
В ситуации, когато се налага да използвате ограничен брой цветове, 
е непрактично или невъзможно да дефинирате цветовете директно.
Ако имате изображение с няколко бита на пиксел (1, 2, 3, 4 или 8, 
например), тогава всеки пиксел е твърде малък, за да съдържа пълна 
цветова дефиниция. Тогава неговият цвят може да бъде описан 
срещу определен индекс в списък или таблица от цветни стойности.
При използване на мастилено-струен принтер или перо за плотер, ще 
бъде много по-лесно, а в повечето случаи и по-прецизно, да 
дефинирате всеки цвят като индекс от списък с точно определени 
цветове, отколкото да използвате неговата действителна цветова 
стойност. В случай, че желаете да ограничите потребителя да използва 
специфичен набор от цветове, можете да ги подредите в списък и да 
ги индексирате.

Цветови и файлови формати за Уеб и печат



Indexed Color модел
Индексираното пространство от цветове е това, което използвате 
при изобразяване с косвено дефинирани цветове. Стойността на 
индексирания цвят представлява стойност сочещо към определен 
индекс от списък с цветове.
Indexed Color е същият като RGB модела и може да се разглежда като 
негова подсекция. Използвайки този модел, вие имате лимит от 256 
цвята дефинирани от кои да е от 16,7-те милиона цвята от RGB модела. 
Софтуерни програми като Jasc's Paint Shop Pro не определят този модел 
като индексиран, а го отнасят към color depth (дълбочината на цвета). 
Индексираният цвят е много важен за GIF изображенията, а те са един 
от най-разпространените графични файлови формати в мрежата.
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1. Формати за цифрова фотография
-PSD
-TIFF
-JPG (по-скоро вид компресия) – не поддържа 16-bit цвят
-PDF
-RAW
-Large Document Format (PSB): за големи изображения 30 000 pixels 
ширина или височина

2. Формати за уеб, мобилни и десктоп приложения
- JPG (за снимки); GIF (GIF е по-подходящ за уеб бутони и банери, 

близките; цветове се трансформират в един – поддържа неповече 
от 256 цвята); PNG (PNG идва в два варианта: PNG-8 (подходящ
за GIF) и PNG-24 (подходящ за JPEG); SVG; WebP...

Цветови и файлови формати за Уеб и печат

https://developers.google.com/speed/webp


WebP – е един от най-модерните формати за уеб. Този стандарт е 
разработен от Google и бе представен официално от технологичния 
гигант преди девет години. WebP е създаден да подобри скоростта на 
зареждане и качеството на снимките в без това да се отразява 
негативно на трафика на мобилен интернет от устройствата ни.
WebP поддържа и прозрачност.

AVIF или AV1 Image File Format, е модерен формат за компресиране 
на изображения с отворен код. Форматът AVIF е базиран на видео 
кодек AV1, който е разработен от Alliance for Open Media (AOMedia), за 
да осигури ефективна и висококачествена видео компресия.

Цветови и файлови формати за Уеб и печат
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3. Формати за печат (задължително в CMYK)
-CDR; AI
-TIFF; EPS (Не избирайте опцията “flatten” или “merge” за слоевете, преди 
командата Save As, за да създадете EPS-а. При записване във формат EPS, 

се уверете, че сте сложили отметка на опцията Include Vector Data”, за 
да получите качествен печат); PDF (поддържа spot color канала, 

прозрачност за разлика от EPS): Да напомним разликата между Spot и 
Process Color. Ако публикацията съдържа само един-два-три цвята, 
например черен текст и сини рамки, то печатът се извършва в два 
етапа: със син цвят се нанасят рамките, а след това с черен се печата 
текста. Тук синята боя задава самият цвят, наречен прост цвят (Spot 
Color), получен като предварително се смесват някои основни цветове в 

смесителя. Този способ на печат е изгоден, когато има само няколко 
цвята, но при печат на цветна снимка, например, вече трябва да се 

използват много нюанси на различните цветове, което го би направило 
безумно скъпо удоволствие.

Цветови и файлови формати за Уеб и печат



3. Формати за печат (задължително в CMYK)
– DCS: DCS 2.0 е вариация на EPS формата, който има поддръжка на 
спот цветове и прозрачност. Използва се предимно при работа с 
програмата QuarkXPress.

 – Indd (InDesign)
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В такива случаи се използва синтез на цвета, с помощта на 
основните цветове – C, M, Y, K. Цветовете получени по този начин се 
наричат съставни (Process Color).

Основните цветове при печат не могат да възпроизведат всички 
оттенъци (нюанси) на цветовете. Например, не е възможно да 
предадат ярко сините и оранжеви тонове, златните и сребърни 
цветове. Затова, за по-точното им възпроизвеждане, се използва Spot 
Color.

Съществуват няколко системи Spot-цветове. У нас най-разпространена 
е системата PANTONE. Издават се каталози на цветовете, позволяващи 
да се избере необходимия оттенък и да се зададе необходимия цвят.

Цветови и файлови формати за Уеб и печат



Цветови и файлови формати за Уеб и печат
В такива случаи се използва синтез на цвета, с помощта на 
основните цветове – C, M, Y, K. Цветовете получени по този начин се 
наричат съставни (Process Color).

Основните цветове при печат не могат да възпроизведат всички 
оттенъци (нюанси) на цветовете. Например, не е възможно да 
предадат ярко сините и оранжеви тонове, златните и сребърни 
цветове. Затова, за по-точното им възпроизвеждане, се използва Spot 
Color.

Съществуват няколко системи Spot-цветове. У нас най-разпространена 
е системата PANTONE. Издават се каталози на цветовете, позволяващи 
да се избере необходимия оттенък и да се зададе необходимия цвят.



Колелото на цветовете
От тези 12 първични цвята се конструира основата на 
Колелото на цветовете.
Всеки цвят, освен определения нюанс, имe и стойност.
Когато към основния нюанс добавим бяло или черно, цвета 
става по-светъл или по-тъмен. Това се нарича стойност.
В колелото на цветовете, тези стойности се изобразяват с 
допълнителни кръгове – два външни за по-тъмните 
стойности и два вътрешни за по-светлите.



Колелото на цветовете



Трудно  ще  срещнете  цвят,  който  е  изолиран  от  всички 
останали. Цветовете вървят в някакви комбинации и се 
интерпретират в съответния контекст.
Ефектът  от  цвета  се  определя  от  светлината,  която 
отразява; цветовете, които го заобикалят и перспективата 
на човека, който го гледа.
Няма  “добри”  и  “лоши”  цветове.  По-скоро  можем  да 
кажем,  че  дадена  част  от  композицията  е  приятна  за 
гледане  или  не.  Има  няколко  основни  комбинации  от 
цветове, които правят избора ни по-лесен.

Колелото на цветовете



Принципът на единството 
изисква използваните цветове да 
са възможно най-близо един до 
друг.
Дизайнерите обикновено 
ограничават спектъра във всяка 
отделна композиция до неголямо 
количество (обикновено не повече 
от 2-3) цвята.

Колелото на цветовете



Принципът на контраста изисква използваните цветове да 
са контрастиращи един на друг.

Правило на тона – не трябва да се използват цветове, които са 
прекалено  близко  един  до  друг  в  цветовия  кръг.  Напълно 
противоположните  цветове  рядко  образуват  хармонични 
двойки.

Най-добре се съчетават и контрастират цветове, разположени 
на разстояние около една четвърт от цветовия кръг
един от друг.

Колелото на цветовете



Принципът на контраста
Разликите в наситеността или яркостта на два цвята веднага се забелязва, но все пак 
тя обикновено се възприема като нещо допълнително към разликата на основните 
тонове.
Добре  е  цветовете  рязко  да  се  различават  по  един  от  тези  два  параметъра, 
засилвайки контраста между тоновете, а по втория – да се поддържат един друг. 
Може  да  се  използва  противопоставяне  на  всички  три  компонента  на  цвета. 
Възможно е да се подчертае взаимодействието между отделните цветове, чрез 
свързването им в особено тесен контраст.

Колелото на цветовете



Цветови схеми
Цветовите схеми са основни модели за създаване на хармонични 
и ефективени цветови комбинации.
Съществуват различни видове цветови схеми:
Едноцветна (монохроматична). Тази палитра съдържа тъмните, 
средните и светлите стойности на един цвят. Тук липсва дълбочина 
в цветовете, но пък имаме контраст от тъмните, средните и светлите 
стойности, което е добро за хубав дизайн.
Аналогична; 
Допълнителна; 
Разделителна; 
Триадична;

Тетриадичена (двойно допълваща се).



.



Монохроматична:

Тази палитра съдържа тъмните, 
средните и светлите стойности 
на един цвят.
Тук липсва дълбочина в 
цветовете, но пък имаме 
контраст от тъмните, средните и 
светлите стойности, което е 
добро за хубав дизайн.
Тази схема съдържа един 
основен цвят и няколко багри и 
сенки на този цвят.

Цветови схеми



Аналогична
Тя е съставена от цветове, които са 
близо един до друг (съседни).
Палитрата съдържа силни полутонове,
които създават приятна за гледане, 
ниско контрастна хармония.
Аналогичните палитри са богати на 
цветове и лесни за работа.

Цветови схеми



Допълнителна цветова схема
Срещуположни цветове - Това са цветове, 
които са директно един срещу друг в колелото 
на цветовете. Срещуположните цветове са 
контрастни, носители на енергия, жизненост и 
вълнение.
Допълнителната цветова схема съдържа 
цетове, които са срещуположни в цветовия кръг. 
Например зелен и червен, жълт и виолетов, или 
оранжев и син.

Цветови схеми



Разделителна
Допълнени-Срещуположни.   Това   са   цветове,   които   са 
разположени  срещуположно  на  основния  цвят  един  от  друг. 
Тяхната сила е в красотата на ниския контраст от аналогичните 
цветове, плюс добавения акцент от срещуположния цвят.
Разделителна  цветова  схема  използва  два  цвята  разположени 
срещуположно на основния цвят.

Цветови схеми



Триадична цветова схема използва три цвята 
равноотдалечени в цветовата палитра:

Тетриадична/квадратична цветова схема 
създадена от избора на цветове в ъглите на 
правоъгълник, оформил се върху колело с цветовете.

Цветови схеми



Съществуват няколко цветови схеми, които не са описани изцяло 
от "колелото". Това са:

Неутралните цветови схеми, които включват само липсващите 
цветове неотразени от колело (различни нюанси на кафяво и сиво). 
Подчертаващи неутрални цветови схеми, включващи неутрални 
цветове като горните, както и един или повече цветни области, 
намерени върху цветното колело.
За един друг по-особен вид цветова схема може да се говори 
тази, съставена от цветове, намерени в природата. Това са 
цветови схеми, базирани на това, което виждаме/срещаме в 
природата.
Може да създадете такава схема въз основа на цветовете, 
които се намират в една снимка.

Цветови схеми



Цветови схеми



Символика на цветовете
Основните три (компютърни) цвята са – червен, зелен и син, също и 
цветовете разположени между тях – виолетов, жълт и небесно син.

В слънчевия спектър, ефекта едва ли е същия, но все пак e забележим.

Той се обяснява с устройството на цветовите рецептори на нашите очи.

В  уеб  дизайна  по-важно  е  посланието,  което  носи  всеки  един  от 
нюансите на цвета.

Тяхното влияние би могло да успокои или разгневи, да завладее или 
отблъсне. Умелото използване на цветовете е гаранция за постигане на 
желания ефект.



ЧЕРВЕН (Eнергия, възбуда, насилие)
Оттенъците на червеното могат да се класифицират като преобладаваща жълта и синя основа. 
Първите са “по-топли”, а тези основани на синия цвят “по-студени”. Именно поради това, 
оттенъците на един и същ цвят предизвикват толкова противоречиви асоциации.

Психологическа символика

Червеният цвят поражда широк кръг от асоциации. Ето го и пълният списък:

Енергия, топло, сила, импулс, динамика, активност, възбуда, смелост, любов, страст, 
доминиращо начало, въстание, агресия, война, насилие, сексуалност, проституция.

Аналогия в природата: Огън, кръв, плът, рози, ябълки, домати, други плодове и зеленчуци, 
рубини.

Използване в съвременното общество: Пътни знаци (забрана), символ на пожарникарите, 
символ на планетата Марс, асоциира се с Нова Година.

Религия: Дявол.
История: Символ на комунизма. Мода: Привличане на вниманието, сексуалност.

Оптически характеристики: Поради силата на своите особености, червеният цвят “изпъква”, 
червените обекти правят впечатление, че са по-близо



ЧЕРВЕН (Eнергия, възбуда, насилие)



ЧЕРВЕН (Eнергия, възбуда, насилие)
Червеното е цвят с висок интензитет и видимост. 
То създава илюзията за нещо, разположено на 
преден план. Затова е подходящ цвят за бутони, 
за да подтиква хората да предприемат или 
действие.



ВИОЛЕТОВ (Мистика, страст, траур)
Виолетовият цвят се среща рядко в природата, затова е разбираемо защо дрехите на 
императорите са били в пурпурен цвят. Навярно с това е свързан и стремежа на човек, да 
разбира виолетовия цвят, като нещо тайнствено и недостъпно.
Психологическа   символика:   Духовност,   мистика,   магия,   вяра,   безсъзнателно, 
достойнство, тайна, креативност, самостоятелност, вдъхновение, страст, чувствителност, 
аристокрация, тщеславие, помпозност, жестокост, траур, смърт.
Аналогия в природата: Орхидеи, ириси, грозде, сливи, цвекло, пурпурни миди — purpura 
(добиват се в Средиземно море, именно те са били източник на пурпурния пигмент в 
древността).

Използване в съвременното общество: Purple Heart (награда за ранените в САЩ), 
използване за обозначаване на радиоактивни вещества.
История: Символ на римската империя.
Мода: В някои страни от Изтока и Европа, виолетовите дрехи са признак за траур.
Оптически характеристики
Виолетовото е един от най-тежките за възприемане цветове.



ВИОЛЕТОВ (Мистика, страст, траур)



СИН (Истина, доверие, чистота)
Синият цвят открива огромна гама от мрачно сини, студено сиви и снежно бели 
тонове. Цветовете от тази зона (зоната на вечния студ) идеално придават
усещане за кристална чистота и ледено спокойствие, без ни най-малък намек за
огън или присъствие на живи същества.
Психологическа символика: Духовност, истина, доверие, чистота, спокойствие, 
удоволствие, пасивност, разбиране, консерватизъм, безопасност, технология, 
мъжественост, студ, прохлада, меланхолия, депресия.
Аналогия в природата: Небе, океан, метличина и други цветя, риби.

Използване в съвременното общество: Джинси, полицейска униформа, задължаващ цвят 
(в пътните знаци).

История: В древен Рим философите са носили сини роби. Символ на добродетелта в 
християнството.

Значение в другите култури: В Китай синият цвят символизира безсмъртие. Цвят на бога 
Кришна и на светостта в индуизма.
Оптически характеристики

Синият цвят има особеността да отива на заден план, сините обекти изглеждат по-далече, 
отколкото са в действителност.



Синьото е цветът на небето и морето. Той има обратния ефект 
на червеното и забавя метаболизма, дишането и сърдечната 
честота. Той символизира мъжествеността и се свързва с 
доверие, лоялност, мъдрост, интелект, опит, доверие, 
стабилност и дълбочина. Синьото създава успокояващ ефект, 
потиска апетита и е считан за цвят действащ отпочиващо на 
тялото и ума. Синьото често се използва за дизайн 
корпоративни сайтове.

СИН (Истина, доверие, чистота)



СИН (Истина, доверие, чистота)



ЗЕЛЕН (Природа, растеж, здраве)
Зеленият цвят в повечето случаи е позитивен цвят, но някои негови оттенъци,
могат да извикат отрицателни емоции, които навяват негативни асоциации,
като: завист, инфантилност, болезненост. В този случай по-голямо значение 
има смисъла на съдържанието. 

Психологическа символика: Природа, растеж, растителност, свежест, спокойствие, 
надежда, младост, здраве, мир, късмет.
Аналогия в природата: Всички растения, изумруди, нефрити, птици, тропически риби.

Използване в съвременното общество: Цветът на разрешаващия сигнал (светофар), 
екология и природоохранителна дейност, долари, маскировка.

История: Зеленият човек е бил бог на плодородието в келтските легенди. Митичните 
Леприкони.
Мода: От дълго време насам, зеления цвят на дрехите е популярен в европейската култура. 
От издържаните тонове модерни през 60-те, беше направен преход до крещящо киселите 
оттенъци на 90-те.
Оптически характеристики: Зеления цвят най-малко уморява очите.



ЗЕЛЕН (Природа, растеж, 
здраве)



ЖЪЛТ (Радост, надежда, философия)
Психологическа символика: Радост, надежда,жизненост, просветление,
общителност, разширение, оптимизъм, философия, егоизъм,нечестност, 
предателство, страх.
Аналогия в природата: Слънце, пясък, есенни листа,пшеница, тиква,
лимони, банани и други плодове, минзухари и други цветя, канарчета и други
птици, злато, топаз, цветът на болно лице, блондинки, шизофрения, цветът на 
урината…
Използване в съвременното общество: Предупредителен сигнал (на 
светофар, за радиоактивност и т.н.), цветът на такситата.
История: Според гръцката митология, косите на боговете са били със златист
цвят, техните дрехи са били също с такъв цвят. Именно поради това този цвят 
не е бил особено любим в ранното християнство.
Символ на жълтото в другите култури: В Китай жълтият цвят символизира
императорската власт. В Индия този цвят е свещен. Любимият цвят на 
Конфуций и Ван Гог. Жълтото е бил важен цвят за ранния Египет.
Оптически характеристики: Най-видимият и ярък цвят в спектъра. Жълтия 
цвят се възприема пръв от човешките очи.



ЖЪЛТ (Радост, надежда, философия)
Жълтото е цветът на слънцето. Яркото жълто привлича 
вниманието, макар че той също може да бъде разсейващо, 
според начина на употреба. Жълтото се свързва с радост, щастие, 
мъдрост и интелектуална енергия. Този цвят стимулира 
умствената дейност и генерира физическата, мускулната 
енергия. Жълтото дава топъл ефект, предизвиква бодрост и често 
се използва за предизвикване на приятни усещания. Нюанси на 
жълтото може да придадат намаляване даден ефект.



ЖЪЛТ (Радост, надежда, философия)



КАФЯВ ЦВЯТ
Кафявото е цветът на земята и притежава способността да се 
смесва с фона. Той е свързан с материалните неща и 
стабилността.



СИВО
Сивото е цветът на скръбта, отделянето и изолацията. 
Той загатва за отговорност и консервативна 
практичност. Това е неутрален цвят и създава 
неинвазивно чувство.
Той се свързва още със зрялост и надеждност.
Сивото може да се използва за намаляване на 
въздействието на друг цвят като оранжевото, например.



“Color is relative.”



Добрият дизайн трябва да "работи" абстрахирайки 
се от цветовете, независимо от тях.

Той трябва да е добре видим в сивата гама. Макар 
цветът  да  е  едно  от  първите  забелязващи  се 
елементи  от  нашата  композиция,  ние  трябва  да 
наблягаме по-скоро върху естетиката на 
елементите.

Цветовите схеми и тяхното значение



Тоест с цветът трябва да се надгражда и усилва въздействието 
на нашия дизайн, а не да бъде самият дизайн!
Цветовете могат да се използват за създаването на визуална 
йерархия и да повишат баланса в дизайна.
Цветът е светлина. Светлината е електромагнитно излъчване 
и  през  обхвата  на  дължината  на  вълните,  въздейства  на 
човешкото  око.  Този  набор  от  дължини  на  вълните  е 
видимият спектър на светлината.

Цветовите схеми и тяхното значение



Чрез смесване на топли и студени цветове можем да придадем 
на нашия дизайн дълбочина.

Цветовите схеми и тяхното значение



За горната част на нашия дизайн може да изберем по-топъл цвят, за да 
си  осигурим  по-голяма  видимост  на  логото.  Естествено  зависи  и  от 
цветовете на последното, заради контраста.

По-тъмните  цветове  имат  за  цел  да  бъдат  забелязани  първи  и 
притежават по-голяма тежест. В този случай е необходимо да се добави 
по-голяма област, покрита със светли тонове.

По-сатурираните цветове (наситени нюанси) придават повече динамика. 
Твърде сатурираните биха причинили умора...

Десатурираните  цветове  помагат  за  по-висока  производителност  и 
ефективност. Те често са по-добър избор за завършване на конкретна 
задача. Комбинацията от ненаситени и ярки цветове се възприемат като 
професионален  избор  и  са  приятелски  за  нашите  очи.  Ненаситени  + 
тъмни цветове се използват за сериозни и професионални дизайни.

Цветовите схеми и тяхното значение



Когато светлината попадне върху 
обект някои дължини на вълните 
се усвояват, а други се отразяват. 
Ние виждаме отразената дължина 
на  вълните  на  светлината  като 
цвят.  Когато  всички  дължини  на 
вълните  от  видимия  спектър  се 
абсорбират   виждаме   черно,   а 
когато   всички   са   отразени   - 
резултатът  е  бяло.  В  зависимост 
кои  вълни  са  погълнати  и  кои 
отразени, ние виждаме 
различните цветове на спектъра.

Цветовите схеми и тяхното значение



Цветът е важна част от дизайна на 
всяко приложение, а умението да 
избереш правилните цветове може 
да подобри или ощети проекта ни. 
Правилото 60–30–10 ще ни помогне 
за първото!

Добре подбраните цветови схеми 
разчитат на контраст и хармония. 
Правилото 60–30–10 е полезен 
инструмент за създаване на 
балансирани интерфейси.

60–30–10 Rule: как да изберем цветовете за UI-а



Това е доминиращият цвят или 
основният цвят. Той е този, който 
изпъква най-много. При избора на 
този нюанс е важно да знаем какво е 
неговото значение. Той трябва да 
отразява посланието на компанията.

Психологията на цветoвете, която 
разглеждахме до сега може да ни 
помогне да изберем цветовете по-
ефективно.

60–30–10 Rule: Step 1 > 60%



След като изберете основния си цвят, можете да използвате онлайн 
генератори на цветове, за да получите останалите два цвята:

https://mycolor.space/?source=post_page-----713b3d4c1445---------------------
------------------

https://paletton.com/?source=post_page-----713b3d4c1445-----------------------
----------------#uid=1000u0kllllaFw0g0qFqFg0w0aF

https://coolors.co/
 

60–30–10 Rule: Step 2 

https://mycolor.space/?source=post_page-----713b3d4c1445---------------------------------------
https://mycolor.space/?source=post_page-----713b3d4c1445---------------------------------------
https://paletton.com/?source=post_page-----713b3d4c1445---------------------------------------#uid=1000u0kllllaFw0g0qFqFg0w0aF
https://paletton.com/?source=post_page-----713b3d4c1445---------------------------------------#uid=1000u0kllllaFw0g0qFqFg0w0aF
https://coolors.co/


Това е вторичният цвят или допълнителният цвят. Той се използва за 
основни елементи като текст, карусели и други важни функции.

Вторичният цвят подкрепя основния, но е достатъчно различен, за да 
създаде контраст.

60–30–10 Rule: Step 3 > 30%



Това е акцентният цвят. Той се използва в бутони, изскачащи 
прозорци, акценти и др.

Ярките, наситени цветове са чудесен начин да добавим визуален 
интерес. Те могат да помогнат да се насочи вниманието към 
конкретни области на страницата или да я накарат да изглежда 
цялостно по-жива.

След като изберем доминиращ цвят, го балансираме с два други 
нюанса, за да получим окончателния дизайн, показан по-долу.

60–30–10 Rule: Step 4 > 10%



60–30–10 Rule: резултати



60–30–10 Rule: резултати



60–30–10 Rule: резултати



60–30–10 Rule: съвети
● Преди да добавим цвят към дизайна ни, трябва да се фокусираме  

върху подредбата и разстоянието между елементите.

● Използването на генератори на цветове може да намали времето, 
нужно за намиране на добра комбинация от цветове.

● Можем да създадем приятна цветова схема с помощта на 
цветовото колело.

● Трябва да разгледаме черното и бялото като цветове, които имат 
собствено значение, това са нашите балансьори в дизайна.



60–30–10 Rule: съвети













https://venngage-wordpress-gallery.s3.amazonaws.com/uploads/2016/08/10-Commandments-of-Color-Theory.jpg


Цветовeте и тяхното влияние при 
изграждане на UI



1. Емоционалната палитра:
   Разбиране на психологията на цветовете

Everything about the color Cinnamon (canva.com)

https://www.canva.com/colors/color-meanings/cinnamon/


2. Прилагане на психологията в UI дизайна

Създаване на идентичност за марката: 

Цветовата палитра на потребителския интерфейс на марката трябва да 
съответства на нейните ценности и послание. Например, приложението 
за здраве и благосъстояние може да използва успокояващи зелени и 
сини нюанси, докато услугата за доставка на храна може да избере живи 
червени и жълти краски, за да предизвика апетит и вълнение.



2. Прилагане на психологията в UI дизайна

Подобряване на потребителския опит: 

Цветовете могат да помогнат за насочване на потребителите в 
интерфейса и за подобряване на използваемостта. 

Например, използването на контрастен цвят за бутоните с призив за 
действие (CTA), ги кара да се открояват и насърчава потребителите да 
предприемат действия.



2. Прилагане на психологията в UI дизайна

Подчертавайки йерархията на информацията: 

Използвайки различни цветове, за да разграничат първичните, 
вторичните и третичните елементи, дизайнерите могат да създадат 
ясна йерархия на информацията, което води до по-интуитивно 
потребителско изживяване и внимание на потребителя.



2. Прилагане на психологията в UI дизайна



2. Прилагане на психологията в UI дизайна

Приспособяване на цветовете към културната среда:

Цветовете имат културно значение и е от решаващо значение да имате 
предвид това, когато проектирате за различни аудитории. Това, което 
може да се счита за положително в една култура, може да се разглежда 
като отрицателно в друга.



3. Примери от реалния живот: Влиянието на цветовете
    в  дизайна на потребителския интерфейс

Пример 1: Facebook

Използването на синьото като основен цвят от Facebook не е 
случайно. Успокояващите и надеждни качества на синьото се 
привеждат в съответствие с целта на гиганта на социалните 
мрежи, да насърчи сигурна и приятелска среда за 
потребителите, с цел да се свързват и споделят.
По същата причина WhatsApp включва и син цвят в 
цветовата си палитра.



3. Примери от реалния живот: Влиянието на цветовете
    в  дизайна на потребителския интерфейс

Пример 2: Spotify

Наситената употреба на зелено от Spotify означава растеж и 
ново начало, идеално за платформа за стрийминг на музика, 
която предлага на потребителите все по-разширяваща се 
библиотека от нови мелодии и изпълнители.



3. Примери от реалния живот: Влиянието на цветовете
    в  дизайна на потребителския интерфейс

Пример 3: WhatsApp

Дизайнът на потребителския интерфейс на WhatsApp демонстрира 
силата на простотата и стратегическото използване на цветовете. С 
чист бял фон и фини нюанси на зелено и синьо като индикатори за 
състоянието и бутони за подканване към действие, WhatsApp 
гарантира, че фокусът остава върху разговора. Успокояващото 
синьо и приятелско зелено допринасят за положително и 
ненатрапчиво преживяване при съобщенията.



4. Примери от реалния живот: употреба на психологията
    на цветовете в UX дизайн

Пример 1: уебсайт за електронна търговия

В условията на електронна търговия цветовете играят важна 
роля в повлияването на решенията за покупка. Използвайки 
цветове като червено и оранжево, за да подчертаят оферти 
или отстъпки за ограничен период от време, дизайнерите 
могат да създадат усещане за неотложност, насърчавайки 
потребителите да правят бързи покупки. Примери за това са 
Amazon, Flipkart.



4. Примери от реалния живот: употреба на психологията
    на цветовете в UX дизайн

Пример 2: приложения за здраве и красота

В приложение за здраве и красота, успокояващите цветове 
като нюанси на синьо и зелено могат да помогнат на 
потребителите да се чувстват спокойни и мотивирани, докато 
се занимават с медитативни упражнения или тренировки.



4. Примери от реалния живот: употреба на психологията
    на цветовете в UX дизайн

Пример 3: новинарски сайтове

Добре организираната цветова схема за новинарски уебсайт, 
с лесно различими секции, може да помогне на 
потребителите да навигират ефективно през различни теми 
и статии.



5. Законът за балансиране: Координиране на цветовете
    в дизайна на потребителския интерфейс

Докато емоционалното въздействие на цветовете е мощно, 
от съществено значение е да се постигне баланс и да се 
избегне претоварването на потребителите. Твърде много 
смели цветове могат да създадат хаотичен и разсейващ 
интерфейс. Дизайнерите трябва да използват цветовете 
стратегически, като гарантират, че подобряват 
потребителското изживяване, вместо да го отнемат.



https://color.adobe.com – или как да си създадем по 
интерактивен начин палитра от множество цветови 
комбинации.

Полезни инструменти за работа с цветове



Полезни инструменти за работа с цветове

https://www.joedolson.com/tools/color-contrast.php – проверка 
на контраста.

http://juicystudio.com/services/luminositycontrastratio.php

http://sixrevisions.com/usabilityaccessibility/14-brilliant-tools-for-ev 
aluating-your-designs-colors/ – набор от полезни 
инструменти за проверка на цветовете.



Полезни инструменти за работа с цветове
http://colormind.io

https://uigradients.com 

https://flatuicolors.com 

https://material-ui.com 

https://colorhunt.co/ https://coolors.co/ 

https://www.figma.com/color-wheel/

https://www.smashingmagazine.com/2010/01/color-theory-for-designers-part-1-the-meaning-of

-color/



Полезни инструменти за работа с цветове
https://www.canva.com/colors/color-meanings/cinnamon/

https://www.w3.org/WAI/standards-guidelines/wcag/

https://color.adobe.com/create/color-contrast-analyzer

https://www.a11yproject.com/

https://www.w3.org/WAI/standards-guidelines/wcag/new-in-22/

https://www.freecodecamp.org/news/the-60-30-10-rule-in-design

https://medium.com/design-bootcamp/60-30-10-rule-how-to-choose-colors-for-your-ui-design-713b3d4c1445

https://saralynnbrennan.com/the-60-30-10-design-rule/

https://www.ibm.com/able/toolkit/tools/

https://www.w3.org/WAI/standards-guidelines/wcag/new-in-22/
https://www.freecodecamp.org/news/the-60-30-10-rule-in-design
https://medium.com/design-bootcamp/60-30-10-rule-how-to-choose-colors-for-your-ui-design-713b3d4c1445
https://saralynnbrennan.com/the-60-30-10-design-rule/
https://www.ibm.com/able/toolkit/tools/


Източници
https://helpx.adobe.com/illustrator/using/stroke-object.html  https://helpx.adobe.com/illustrator/using/painting-
fills-strokes.html 
http://blogs.adobe.com/adobeillustrator/2013/08/adobe-illustrator-tutorial-by-madis-poldsaar-creating-stylize 
d-hair.html
https://helpx.adobe.com/illustrator/using/apply-or-edit-gradient.html 
http://graphicdesignjunction.com/2014/05/illustrator-tutorials-how-to-make-vector-graphics-in-adobe-illustrat 
or-15-tuts/
Goin L., Design for Web developers – Colour and Layouts for the Artistically Overwhelmed, Dynamic Zones 
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